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Welcome to the latest edition of my monthly Final Cut Studio newsletter for June, 2010.

The goal of this newsletter is to provide information helpful to the interested user
of Final Cut Pro. This newsletter publishes each month, past issues are available
in my store. All software references are to Final Cut Studio (3) unless otherwise
noted.

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll
find daily tips, the latest industry news, and almost 500 articles and tutorials to help
you get the most out of Final Cut Studio!

If you haven't done so already, each issue of this newsletter is FREE -- subscribe here. Then,
follow us online:

Larry on Facebook
Larry on Twitter
Latest Industry News from the Digital Production Buzz
Larry Jordan's Blog
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Short takes on interesting subjects.
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Problems With Multiclips
Audio Thoughts
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Working With Keynote Files

WRAP-UP

WELCOME

And welcome to summer! Look at this, the June issue of my
newsletter is out -- and its STILL JUNE! Wow...

I have a killer issue for you this month! I've finally had time
to write some articles that I've been thinking about for
several months.

We launched a new Webinar series at the end of May that
is very successful - so successful that we have expanded it
to a new session every week, starting July 7. I'll tell you
more about this in a few pages.

Plus, we are making these webinars available in our store -
you can buy the first three right now.

Last month, we started a two-part series on creating menus
in DVD Studio Pro. This month, we conclude with a look at

how to create motion menus for your DVDs

Also, several months ago, a reader wrote asking how to mix audio when your audience has
trouble hearing. I've been reflecting on that ever since he asked the question -- because my
hearing isn't what it once was and that troubles me a lot. I think I've got some good answers,
which I'll share in this issue.

Finally, we have a "breaking news" story. A couple of days ago, Oxygen Cloud announced a
new way to share files and collaborate via "the cloud." As I was prepping this issue, I spoke with
Peter Chang, their CEO and founder, about what this means and what the benefits are to us.

OH! We now have our own Forum to answer your questions. Read about it here, and visit it
here!

It is good to be back with you. I truly enjoy your comments on each issue -- keep them coming!
So let's get started with Peter Chang.

[ Go to Top. ]
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THOUGHTS ON "THE CLOUD" 
AN INTERVIEW WITH PETER CHANG

One of the new buzz words floating around these days is "the cloud."

Though it has a nice sound -- "instantly access any of your files from the
cloud" -- I am deeply suspicious of storing any files where I can't see
where they are located; or control who has access to them.

I'm reminded of a line from a Harry Potter book: "Never trust anything when you can't see where
it keeps its brain."

With that as perspective, I had a call on Friday from Peter Chang, who's the CEO and Founder
of Oxygen Cloud. They announced a new cloud-based file-sharing service on June 24 that goes
beta in July and ships later this year.

According to their website (www.oxygencloud.com):

Oxygen Cloud connects all people, data and devices to a single file system. The
company is delivering native desktop collaboration and cloud storage brokering to
business end users.

First, a non-technical definition. A "cloud" is a pool of storage resources that can scale to any
arbitrary size. There are public clouds -- Amazon Web Services, Nirvanix, Iron Mountain -- which
make their storage available via the Internet.

However, there are also private clouds, which are owned, controlled, and operated by a private
company on their own site. These private clouds can be located either inside or outside the
company's firewall. The new Drobo FS was specifically designed for this purpose.

The key concept is that, while a cloud is fixed in location, it is not fixed in capacity. Thinking
about a cloud means not thinking about a storage device, but instead as a storage space.

My first question to Peter was, "why even bother with clouds, they sound suspiciously like a file
server?" The answer is both simple and complex. A hard disk, or RAID, attached to a file server
is both a specific location and a specific size. When that drive fills up, you either need to add a
new one, thus creating a new device in a new location, or replace the unit with a larger one,
thus necessitating a lot of file transferring. What a cloud does is replace a single point of storage
with an expandable amount of storage. That way, as you need more storage, you simply expand
the cloud, without having to contact users whenever changes are made to where they can store
files.

But, according to Peter, file servers also have inherent problems:

They can be difficult to connect to from outside the company. Getting a VPN set up and
working, I know from personal experience, is not a fun activity.
As our computing becomes increasingly mobile, accessing files from a variety of mobile
devices becomes increasingly challenging.

Peter continues, "wouldn't it be cool if..."

You could access a file from anywhere in the world, on any device?
All data was fully encrypted, both during transit and when stored?
All files are tracked, with a full audit trail?
You had a simple user interface that allowed you to find any file?
You could see who accessed a file, what changes were made, and where it is stored?
Provide a way for users inside and outside a company to collaborate?
The folks in IT can manage the whole system easily?

http://www.oxygencloud.com/
http://www.oxygencloud.com/


That's where Oxygen Cloud comes in. They provide the software in the middle between "the
cloud," which is storage hardware, and the user who needs to access the data. Servers store
data. The Oxygen Cloud system manages it. Think of them as a media asset manager, that's
managing all your files, not just media.

Now, I agree, that the list of questions posed by Peter is very much like asking whether you like
motherhood and apple pie. Still, it raises some interesting thoughts.

Peter tells me that setting up a cloud is traditionally not trivial. And we all know how hard it is to
create an easy-to-use asset manager. What Oxygen Cloud has done is create an interface
similar to a folder in the Finder that you open to find your files. "Oxygen has done a lot of work."
Peter said, "to make our software a very light-weight middleware so that files can move through
the system at whatever speed the network supports."

This file management software is a paradigm for how to manage files. It only points to files on
the cloud. Oxygen shows all files, but only provides links to where the files are stored. Supports
all types of files for all applications.

Oxygen tracks all metadata for files, who is doing what, and where is it stored. Oxygen also
stores all content in the cloud and connect it to a familiar experience - like opening a hard disk
icon. It allows users to see the history, prior versions, add comments, and collaborate on files
among other things.

While this system is not designed for managing the massive media files we need for editing, it
sounds attractive for managing the creative, collaborative process of production.

To learn more, visit Oxygen Cloud (www.oxygencloud.com) and signup for their newsletter.
When they release the software, you'll be able to download a desktop application that looks like
the Finder. The cost is expected to be $10 per month.

I'm still not convinced on all the security issues. However, the world and our production teams
are increasingly going mobile. This might be one way to enable them to do more with the
resources we already have.

This strikes me as something worth investigating further.

[ Go to Top. ]

A GREAT NEW WAY TO LEARN SOMETHING -- WEBINARS

We launched our latest training series in May -- web-based PowerUP
seminars - and they were very successful! So successful that we created a
series of weekly events for the summer; each week we present a new
subject. We call these "webinars."

Web-based training is less expensive (for both of us) than in-person
training; plus, with our live chat and video, it is highly interactive.

We conduct a new webinar every Wednesday - at three different times during the day. Here's
our schedule for July:

July 7: Video Compression for Web and DVD
July 14: Working with Tapeless and DSLR Media in Final Cut Pro
July 21: Reading Video Scopes and Learning Color Correction
July 28: Fixing Bad Audio in Soundtrack Pro

We keep each class small, so you can get your questions answered using our live, interactive
chat.

Best of all, we keep the price small as well -- one hour of training for only $49.

http://www.larryjordan.biz/sem/webinar_2010b.html
http://www.oxygencloud.com/
http://www.larryjordan.biz/sem/webinar_2010b.html#july7
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http://www.larryjordan.biz/sem/webinar_2010b.html#july21
http://www.larryjordan.biz/sem/webinar_2010b.html#july21


PLUS, if you can't make the live event, we make each webinar available in our store about a
week after the event. We already have three titles available, with more added each week:

Avoiding Dropped Frames - Picking the Right Storage
Making Your Video Images Look More Like Film
Compression Techniques for Transcoding Video

Our most requested seminar is only a week away - Compressing Video for the Web and DVD
- register today before all the seats fill up.

Click here to see the agenda and sign up.

[  Go to Top. ]

CREATING A MOTION MENU FOR DVD STUDIO PRO

Last month, I wrote about how to create a DVD menu using overlays. This month, I want to talk
about how to create a motion menu, and using overlays to highlight buttons. (Click here to read
last month's article.)

Several different ways are available to create a motion menu:

In Final Cut Pro
In Motion
In LiveType
In DVD SP itself
In another motion graphic application

While all of these will work, the process is essentially the same once you get the movie created.

The easiest way to think of DVD Studio Pro (DVD SP) is that it is a wiring-and-plumbing
program. You create the assets you need OUTSIDE of DVD SP, then hook them together
INSIDE DVD SP.

CREATING THE MOVIE

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=177
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=178
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http://www.larryjordan.biz/sem/webinar_2010b.html
http://www.larryjordan.biz/articles/lj_DVD_menus.html


I created a 39-second movie in Final Cut Pro entitled: "The Interplanetary Internet, hosted by
Dr. Vint Cerf." This will be the movie we use for our motion menu. Note that it was created
outside DVD Studio Pro, then be brought into DVD SP for the menu.

NOTE: I am indebted to Dr. Cerf and Alcatel Corp. for allowing me to use this
footage from an interview I did with him a few years ago. Also, this title is purely
for this tutorial. If you are actually creating a similar program, don't panic. This is
just a demo.

Looking at the timeline, the movie starts with Dr. Cerf full screen, then some animation kicks in,
followed by Dr. Cerf composited into the animated footage. The motion menu is him stating that
research is being done to extend the internet into outer space. Cool.

The music bed was created in SonicFire Pro 5. The background and text animation were
created in LiveType. The source footage is 4:3 DV, scaled and cropped to fit as a vertical image
in the menu.

The menu timings are:

0:00 Fade in
8:24 Start animation
14:15 Animation complete
38:24 Motion menu complete



(If you want to see the finished movie, click here. Be sure to open this in QuickTime, it may
want to open in iTunes.) I think an interplanetary internet is weird, but very cool.)

By the way, one thing I did in Final Cut before exporting the movie was to set a Compression
marker at the exact point my text animation completed. I'll make note of the timecode (14:15)
and use this for a Loop point when the movie is imported into DVD SP later.

NOTE: When exporting a movie that contains markers, be sure to select: Include
DVD Studio Pro markers in the Markers menu during export.

Now that the movie is complete, here are the steps we will follow:

1. Create overlays in Photoshop to use as Button Highlights (you could also use templates
from within DVD Studio Pro).

2. Compress the movie. Normally, I'd do this in Compressor. However, as the movie is
already in DV format, and I don't want to take the time to explain how to use Compressor,
I'll compress it using DVD Studio Pro.

3. Import the movie and overlay into DVD SP.
4. Create the menu and add the movie, buttons, and highlights.

Let's get started.

CREATING THE OVERLAY

In Final Cut, put your playhead over a section of the motion menu where all button animation is
complete and everything is in its final layout.

Select File > Export > QuickTime Conversion.

http://www.larryjordan.biz/assets/nxltr69/Motion_Menu_movie.m4v


In the Save dialog that appears, change the Format to Still Image. Give the file a name and
location and click OK. The default image format is PNG which is fine for what we want to do. (In
the old days, I would change this to TIFF, but PNG is easier to use.)

Open Photoshop and import your freeze frame. It will look stretched and may also look
interlaced. Colors may look dark as well. All of these are normal. We are just using the still
frame as a reference, not as an actual image; so the quality is not an issue.

Add a new layer to your Photoshop image (Shift+Cmd+N) and name it Overlays. Click OK to
save the layer.

A highlight is an object that changes color to show the DVD viewer what menu choice they have



selected. This object can be something you draw, import, or create using one of Photoshop's
Shapes. In my case, I'm going to use the Shape tool.

NOTE: The one thing I strongly discourage is trying to change the color of text in
DVD SP. It looks awful! DVD SP does not support text aliasing, which means that
overlaying colors on text looks blocky, chunky, and unpleasant. A simple geometric
shape works perfectly and looks far better.

Select the Shape tool from near the bottom of the tool palette. You may need to hold down the
tool button, as it shares this menu position with other tools. If you haven't used this tool before,
the icon has the shape of the Line tool.

Go to the Toolbar at the top, and click the Shape menu. This shows all the different shapes you
have available. The part of a shape that is black can change color. That part that is white will
not.

Type D to set Photoshop's colors to their default black and white.

Select the new layer and draw your shapes on the menu where you want them to appear on the
DVD. The shape you draw must be pure black with no shades of gray.



To draw a symmetrical shape, hold the Shift key. To draw the shape from the center, hold the
Option key.

It is really important to position the shape where you want the highlight to appear on the DVD
menu. To make copies, hold the Option key and drag the shape to a new position.

NOTE: You can not reposition graphics in DVD SP. So take time to be sure they
are correct in Photoshop. This is why we created the still frame, to give us a
position reference for placing our shapes.

When you are done, you'll have as many new layers as you added shapes. Because shapes are
vectors and video wants bitmaps, we need to convert each shape layer to a bitmap.



Go to Layer > Rasterize > Shape. This does the conversion. Do this for as many layers as you
have shapes.

Turn off the background layer by clicking the small eye to the left of it in the Layers menu. Make
sure only your shape layers are selected.

Then, choose Layers > Merge Down. This combines all the shape layers into a single layer,
which has the name of the layer we created a few steps ago.

Be sure the eye is still turned off for the bottom layer, since we don't want to see the freeze
frame we used to set the position of the overlays, and File > Save the file as a Photoshop
document (PSD).

CREATING THE MENU

Open DVD Studio Pro and import your motion movie and the overlay file you just created. Click
the Import Asset button in the toolbar to open the import dialog.



The yellow dots next to the name of the file indicate that it needs to be compressed, which DVD
SP can do IF you give it standard-def media. DVD SP can not compress HD media into
standard-def, for that you would need to use Compressor.

Click the Graphical tab to select it, and drag the video file of your motion menu on top of the
Menu 1 graphic. Feel free to rename this menu, if it helps you keep track of your project.

NOTE: When a QuickTime movie is imported into DVDSP, it is converted into two
separate files: one for audio and one for video. These are called MPEG-2
Elemental files. If you drag the video file into a menu or track, the audio file will
follow automatically.

Click the menu tab to display your new motion menu. Now we need to add buttons. If you
started with a fade up from black, as I did, click the small "running man" icon in the lower right
corner to playback your menu.

Drag the PSD file containing your overlays directly on top of the menu and wait for an overlay
menu to appear. Drop the file on Set Overlay, since we want to keep the movie as a
background.



In the Inspector, go to the General tab. Notice in the center of the Inspector, it shows your PSD
file as the source of the overlay. From the Overlay layer menu, select the name of the layer that
contains your overlays. In our case, we named this Overlays.

Play your animation and drag a rectangle around your button text in the menu window itself.
This sets the region where a mouse can click to trigger a button, as well as telling DVD SP how
many buttons are on the menu and where they are located. Be sure to include room for the
overlay graphic as well.

Be sure to create the region after the animation is complete. Repeat this process for every
button so that every button has a region drawn around it.



The problem now is that the buttons appear at the beginning of the menu. What we want them
to do is to appear when the animation is complete. The point where repeats start is called the
Loop Point. To create one, select the menu by clicking it. Don't select a button, just the menu.

NOTE: The Loop point also determines when buttons become active. You won't be
able to click a button until the DVD playback reaches the Loop point.

In the General tab of the Inspector, the Loop point determines where a repeating menu will
jump to after the menu has played through once. In our case, the animation is complete after
14:15. So that's what we will set for the Loop point.

Below the three windows, is the At End menu. This tells the menu what to do when it is done
playing. By default, this should set to Loop. If it doesn't, set it to Loop.

NOTE: Because of the way video for DVDs is compressed, you may not be able
to get the exact frame you need. This is the reason we set a Compression marker
at the beginning of this tutorial. Also, Motion has a special marker, called the Loop
marker, that automatically sets the loop point for menus created in Motion that are
imported into DVD SP, which will automate this process.



Finally, select a button and assign a color to it. Since we are only using one color for our
overlay, select "Simple" overlays. We talked about the three selection states of a button in last
month's article.

And that's it. Amotion menu, with overlays. Done.

NOTE: The actual time to complete this task, includingcreating the movie and
writing this article, took about 90 minutes. So, while there are a lot of steps, once
you understand the process, it doesn't take long at all.

[ Go to Top. ]

LARRY IS ON TWITTER... AND FACEBOOK... AND...

Ever hip to the latest trends, though, ah, maybe not jumping on them immediately, I'm now on
Twitter (LarryJordanFCP) and Facebook.

Well, I've been there for a while, but I haven't really mentioned it here before. So, now I'm
mentioning it.

We are trying to do a Twitter post at least once a day and Facebook is constantly updated with
new stuff.

If you want to know my reactions to what's happening in the industry, follow me on
Twitter.
If you want to know the latest news about our industry, check out the Latest News
section of the Digital Production Buzz. We update this daily. You can also add this
feature to your website to boost your own traffic.

http://twitter.com/LarryJordanFCP
http://www.facebook.com/pages/Larry-Jordan/174158732452
http://twitter.com/LarryJordanFCP
http://www.digitalproductionbuzz.com/news.php?newsid=0


If you want a more broad-ranging coverage, follow us on Facebook.

And, not to worry, I'll still be here publishing this newsletter every month.

Pick the media that works the best for you. And, as always, I enjoy hearing from you.

[ Go to Top. ]

EXPLAINING AVCHD DISCS

In spite of what you may think, optical media is not dead. Money can still be made in optical
media. In fact, we have an extra option you may not know about: AVCHD Discs.

Just as we have two broad categories of video, we have two categories of optical media:

* DVDs for standard-definition media
* Blu-ray Discs for high-definition media

DVD Studio Pro only creates standard definition discs (see my note on HD-DVD later in this
article). This means that if you want to create HD discs, you need to use other software to
create it.

Blu-ray Discs can not be created using your built-in DVD burner, you need to purchase an
external device. Also, currently, Blu-ray Discs can not be played on any Mac using any version
of OS X. (Yes, there are third party drivers you can purchase, however, as shipped, Macs won't
play Blu-ray Discs and still require an external, or third-party, player.)

This means that you need to purchase an external burner, along with a player and monitor to
view the discs you create. Currently, the best option for Blu-ray playback is a PS3. NOT that
any of us would use this to play games! Certainly not. We are getting this solely as a legitimate
business tool.

That's my story and I'm sticking to it.

However, in addition to Blu-ray Discs, within the world of HD are two other optical formats:

* HD-DVD
* AVCHD

HD-DVD was a format primarily promoted by Toshiba that was a competitor to Blu-ray Discs,
which was primarily promoted by Sony. However, Toshiba pulled HD-DVD from the market in
February, 2008. While DVD SP can create disks in the HD-DVD format, there isn't a player on
the market that can play them. Consider this a dead format.

But AVCHD is quite alive. AVCHD is a compromise between a standard DVD and a Blu-ray
Disc, in that it burns high-def media formatted as Blu-ray using a standard-def burner on regular
DVD media. You still CAN'T play an AVCHD disc on your system, but you CAN create it.

However, this flexibility has its limits. First, you can only put 20-30 minutes of HD material on an
AVCHD disc. Second, the data rate is lower than a standard Blu-ray Disc. Which means that
the image quality will be close to, but not as good as, a true Blu-ray Disc.

In many conversations about this with Bruce Nazarian, the president of the IDMA, this trade-off
in quality may look OK to you. Apple has done a great job of optimizing the compression of HD
media for AVCHD discs.

To create AVCHD Discs requires Final Cut Studio (3). Create your project in Final Cut Pro7,
then use File > Share to open the Sharing menu. Then select Blu-ray Disc as a destination.

This is ideal for burning a single movie to a disc. You can't create menus, or author a DVD, that

http://www.facebook.com/pages/Larry-Jordan/174158732452
http://www.idmadvda.org/


requires Adobe Encore.

But, if you have a client that absolutely needs HD on optical media, and the total running time of
the media is less than 30 minutes, you can meet their needs using AVCHD and Final Cut Pro 7.

UPDATE - July 1, 2010

Jeffrey Abelson asks:

Just read the piece in your newsletter about AVCHD discs, and was unclear
where or how one would play these discs. You state emphatically they won't play
in a standard Mac, but will they play in a standard-def DVD player on your TV?
Or will they only play in a Blu-ray player?

Larry replies: AVCHD discs only play in Blu-ray Disc players, not in a standard-def DVD player.

[ Go to Top. ]

REDUX: INTERLACING AND DEINTERLACING

I received several emails this week from people concerned that their videos had suddenly
developed a serious case of the "jaggies."

They hadn't. What they were seeing was interlacing.

There are two ways an image can be captured: progressive and interlaced. Which version you
capture depends upon your camera and the video format you are using.

The original way video images were captured was interlaced. All NTSC, all PAL, and all 1080i
HD formats are interlaced. They record an image in two groups; one group is all the pixels in
the even-numbered lines, the second group is all the pixels in the odd-numbered lines.

In the case of NTSC, the even-numbered line group is recorded first. Then, 1/60th of a second

http://www.adobe.com/products/creativesuite/production/


later, the odd-numbered line group is recorded. (HD formats generally record the odd-numbered
lines first.) This means that anything in your image that's moving has half its pixels time-shifted
by 1/60th of a second.

NOTE: If you work with PAL, the process is the same, but the time-shift is 1/50th
of a second.

Interlacing had its genesis at the very beginning of television as it solved technical problems
related to the display of images on a phosphor-coated TV screen, as well as minimizing
bandwidth during transmission.

The entire television industry was founded on interlaced images which worked great, as long as
you were viewing them on a TV set.

The second way video images are captured is progressive. Progressive images are indicated by
the letter "p" in the format name: 720p, for example. Here, the camera captures all the image
pixels at one time. Film has always worked this way, but this process is relatively new to video.

While interlacing is traditional, it totally breaks down when you view images on a computer,
because the computer always displays images progressively.

If you are shooting video to burn to a standard-def DVD, interlacing is fine. Its part of the
format. It may look a bit strange in Final Cut, but it will look fine on your DVD.

If you are creating video for the web, interlacing will drive you nuts.

Ideally, you should shoot progressive video - because progressive footage guarantees no
interlacing. It is far easier to convert a progressive image to interlaced than an interlaced image
to progressive. We've been doing this successfully with film for decades.

The ideal format to shoot in is 1080p. However, that gear tends to be expensive. For me, I do all
my work as 720p. Since everything I do goes to the web, 720p gives me all the quality I need
using affordable cameras. Even high-def websites only display 720p video.

But, what if you need to go to the web and all you have is interlaced footage? Well, the answer
is easy, but not ideal -- you need to deinterlace.

Here's my suggestion: never deinterlace in Final Cut Pro. Only deinterlace when you are
compressing your final image for the web.

NOTE: Well, OK. You can deinterlace in Final Cut Pro if you have a freeze frame,
or a still image that is vibrating badly. What I mean is that you should not
deinterlace your entire program in Final Cut Pro. First, the render times are
LOOOONNNNG, and second, the quality is not the best.

Edit the format you shot in Final Cut Pro and export it in that format using File > Export >
QuickTime Movie. This gives you the highest-possible quality throughout the entire editing
process, including export.



If you are outputting to DVD, interlacing is fine, because all DVD formats are interlaced.
If you are outputting for the web, you will need to remove interlacing during the
compression process for the web. The problem with removing interlacing is that it
decreases your image quality - a lot.
If you are going to digital projection, meaning theatrical, you really need to shoot a
progressive image, because deinterlacing removes image quality.

Here's why. In the image above, the red lines represent the time-shifted pixels which we need to
remove to eliminate interlacing.

However, if we remove half the lines, we automatically cut our vertical resolution in half --
because half the lines are now missing. For the web, where we traditionally reduce the size of
our images, this may not be bad. But for projection, it creates an automatic drop in image
quality.

This is why it is useful to think about where your finished video will be viewed before you pick
the camera and video format to shoot.

Before you deinterlace your image - and remember, don't deinterlace inside Final Cut Pro - think
about what your final image size will be.

Since deinterlacing removes 1/2 the lines in your image, if your final image size is smaller than
1/2 the original, you don't need to deinterlace at all - it will happen automatically.

For example:

* You shot a progressive format. You don't need to deinterlace.

* You shot 1080i. If your compressed image is equal to or smaller than 960 x 540,
you don't need to deinterlace.

* You shot 720i (a format that I don't think exists). If your compressed image is
equal to or smaller than 640 x 360, you don't need to deinterlace.

* You shot NTSC or PAL. If your compressed image is equal to or smaller than
320 x 180 (or 320 x 240 for 4:3 material), you don't need to deinterlace.

In most cases, deinterlacing is handled automatically by your compression software. However,
deinterlacing will be required for NTSC or PAL images displayed at full screen size: 640 x 480.
The best place to deinterlace is in your compression software.

If you want to know how to do your own deinterlacing, here's a video tutorial I recorded on how
to deinterlace inside Compressor.

[ Go to Top. ]

WHAT VIDEO FORMAT TO SHOOT

Steve Schafer asks:

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=155


I was at a Gnomon event and asked them what is the format I should be shooting
with my HVX200 for FX later in FCP or Motion or after Effects. The told me 1080i
was better than 720P. This seemed odd to me as interlaced seems inferior. I was
later at an Creatasphere event and there was a well know special effect house
there (located on sunset in hollywood) and I asked the same question they also
told me 1080i was preferred to 720P. They claimed there was more information
from which to do the effect. You stated in your presentation that Progressive was
preferred and so now I am still left baffled as to what I should be shooting to my
HVX200 at for the best resolution and look in FCP, Motion and After Effects.

Larry replies: Steve, there is more horizontal information in a 1080i image, but more vertical
information in 720p due to the problems caused by interlacing.

The ideal format to shoot is 1080p, as that can be converted to anything. However, I would
disagree with their opinions that 1080i is better than 720p. Especially with ah HVX200, which
stretches a horizontal resolution of 1280 pixels out to 1920. In other words, the horizontal
resolution of the HVX-200 is the same whether you are shooting 1080 or 720!

On the other hand, I've been wrong before and if a reader has a differing opinion I'm happy to
share it with all of us.

[ Go to Top. ]

ANNOUNCING SOMETHING NEW AND FREE -- 2 REEL GUYS

On June 15 we announced 2ReelGuys.com - a website
devoted to the creative process of visual story-telling.

Norman Hollyn and I have been working on this project
for the last year. And I'm delighted to introduce it to you
today.

We spend a lot of time talking about technology.
However, 2 Reel Guys is dedicated to the creative
process of visual storytelling. These short, 10-minute
video vignettes shows that telling a good story doesn’t
require a lot of money – a lot of gear – or a lot of people. Mainly, you just need the knowledge
of how to shape the story into something other people want to watch.

The first two episodes are posted, episode three - on working with actors - posts July 1, and we
will release a new episode on the first and fifteenth of every month. The first twenty episodes
are in the can, now all I need to do is get them edited...

We designed these to be used in the classroom to spur discussion, or as a refresher for people
working in the industry. Check out our list of future episodes and you'll see what I mean.

I am very excited about these and hope you like them. Feel free to add comments on the 2 Reel
Guys Forum - it's a place to discuss the creative process.

(By the way, the irony of being sponsored by Avid Technology is not lost on me.
Still, we could not have done this without their help and I am grateful.)
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SOLVING PROBLEMS CAUSED BY AUDIO SAMPLE RATES THAT DON'T
MATCH

I got burned by this when I was prepping my most recent webinar for posting. My audio slowly

http://www.2reelguys.com/
http://www.2reelguys.com/
http://www.2reelguys.com/
http://www.2reelguys.com/store/
http://www.avid.com/


slipped out of sync.

I hate when that happens.

What I discovered is that the Soundtrack Pro sample rate preference setting overrides the
sample rate of the Final Cut Pro project, resulting in a slow sync drift that will drive you nuts.

Because there are a variety of places where you can choose the wrong sample rate, I wanted to
walk you through my process of posting a webinar to show you where the problem occurred and
how to prevent it.

I record all my tutorials and webinars using Telestream's Screenflow. When I am ready to export
the file for editing, I always select "Lossless" to give me the highest quality for editing and
compression.

Then, for audio, I exportthe file as a Linear PCM file. (See the article below on choosing the
right version of "Endian-ism.")

Here's the first opportunity you have to screw things up. Notice that the sample rate is set to
48.000 kHz. The problem is that my audio gear, like most audio gear, records at 44.1 kHz. (Both
are excellent choices from a quality point of view.)

While Final Cut can easily handle both 44.1 and 48 kHz sample rates, it prefers 48 kHZ. At
least, that's been my experience when working with the Animation codec and synced audio.

So I make sure to set the audio rate to 48 kHz and export.

When getting ready to edit this in Final Cut, I create a new sequence, then drop my clip into it.

http://www.telestream.net/screen-flow/overview.htm


If I get a message asking if I want to change the sequence settings to match the clip, I say Yes.

Then, I remove the clip from the sequence and check Sequence > Settings. Removing the clip
allows me to adjust all the settings, which can't be done once a clip is in the Timeline. The main
thing I am checking is to be sure my audio sample rate is set to 48 kHz. If not, I change it.

Once I verify my sequence settings are correct, I edit my project as normal. Because both audio
and video settings of the clip match the timeline, there's no rendering until I add effects.

Finally, I do all my audio clean-up and mixing in Soundtrack Pro. Here's the third place the
sample rate can get accidentally reset.



                   

Before sending my file to Soundtrack Pro I SHOULD have (but didn't) check to be sure the
sample rate preference was set correctly.

To check it, go to Soundtrack Pro > Preferences > Project tab and make sure the project
sample rate is set to 48000 (48 kHz).

Then, File > Quit Soundtrack Pro.

In Final Cut, select your sequence in the Browser and File > Send it to Soundtrack Pro.

When Soundtrack opens with your sequence in it, be sure the project sample rate is set to 48
kHz. You check it by looking in the top of the Soundtrack Pro tool bar. If this, too, is set to 48
kHz, all your audio sample rates match across all your programs.

At this point, you've maintained a consistent sample rate across all your software and elements
and sync will remain constant and locked.

Yes, I've added this to my editing checklist.
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ANNOUNCING THE LARRY JORDAN FORUM

Here's another project we've been working on for the last several
months: a Forum for our website!

Yes, I know there are plenty of other forums out there. And some of
them are very good. Why create one here?

Well, the answer is that I get about 200 emails a day from people
asking questions. Questions that they can't get answered anywhere

else. And I try to respond to every one of them the same day.

The nice thing about this is that I get a really good idea of what common problems are. The bad
thing is that I end up repeating the same answers over and over and no one else benefits from
our conversation.

It struck me a while ago that putting together a forum, where we can all share questions and
answers, would help all of us. This website is specifically focused on Final Cut Studio, so that's
the general focus of the forum as well.

It's all FREE and I'd love you to check it out. Visit: www.larryjordan.biz/forum.
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IT AIN'T THE ENDIAN OF THE WORLD

In the category of "there's always something more to learn," I was conducting a webinar on
video compression last Wednesday when I was struck by something that didn't make sense.

When creating an uncompressed audio file - whether WAV or AIF - we have the option of
making it "Little Endian" or "Not-Little-Endian." The not-Little-Endian format is called "Big
Endian," though you would not know that from the checkbox.

http://www.larryjordan.biz/forum
http://www.larryjordan.biz/forum


As I was rehearsing for the presentation, I was working on a G-5 computer, and got the screen
you see below.

Then, when I was presenting on my MacBook Pro, I got a different screen. Notice the checkbox
for Little Endian -- both of these screens display the default settings for their respective CPUs.

After the presentation, I was troubled by the different screens and wanted to be sure the
information I was giving was accurate. So, I contacted some friends at Apple who are paid to
know about these things and asked: "Whether Final Cut Pro prefers Big Endian or Little Endian
audio for versions 6 or later."

Here's the response I got from Apple.

PowerPC computers create Big Endian files. Intel/Mac computers create Little
Endian files. From Final Cut's point of view, it really doesn't matter. Not even in
terms of a "preference." The conversion from big to little endian is far below the
noise level of performance compared to the actual read from disk.

Internally, we use the native endian-ness of the machine upon which we are



running (big for PowerPC, little for Intel), of course, but that's internally (i.e. once
files have been read and we are processing data in the audio engine).

From a file-reading perspective though, as long as the file is legally and properly
annotated, we do not care whether it is big or little endian.

Cool. In other words, if you are creating files on a Power PC, uncheck Little Endian. If you are
working on an Intel/Mac, check Little Endian. Both of these settings should be the default for
your system. And add another piece of trivia to the pile. Thanks, Apple!
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AUDIO MIXING TO IMPROVE THE CLARITY OF SPEECH

This article was suggested several months ago by Philip Fass. Sorry it took me so long to write.

One of the signs of getting older is that our hearing is not as sharp as it once was. (Yes, that
includes me, too, and I'm still frustrated about it.) So one of the things I do in my mixes is to be
sure that I make things as clear and easy to understand as possible.

But first, a bit of audio theory.

VOLUME AND FREQUENCY

We frequently think about the loudness of a sound making it understandable. But that is only
part of the solution.

All sound is composed of two elements: volume and frequency. The volume determines how
loud a sound is, the frequency determines the pitch.

NOTE: Volume is also describe as "levels" and "gain." Your choice.

When someone speaks, their voice contains lots of different volumes and frequencies. You can
easily prove this to yourself by trying to make words using just a tone generator, like the one in
Bars and Tone. You will get a series of beeps, but no words.

Human speech is "bursty." This means that each syllable is a short burst of sound. These are
the puffs we see when looking at waveforms in Final Cut's Viewer or Timeline. Singing is more
"steady-state."

Here, for example, is a waveform of me saying: "to learn more about our weekly podcasts, visit
DigitalProductionBuzz dot com."

Each syllable is its own puff. The two puffs at the end are "dot com".

But looking at a waveform only shows the volume of the sound. We need to look at a frequency
chart to see the distribution of frequencies.



Happily, Soundtrack Pro provides this as part of an Audio File project. Here is the spectrum
analysis for the words "dot com". "Dot" is on the left and "com" is on the right.

This chart represents the frequency range and characteristics of human hearing.

* Blue represents the frequencies at which there is no sound at that point in time
* Pale blue represents frequencies with some level of sound
* Green represents frequencies with a moderate level of sound
* Dark green represents frequencies with a significant level of sound
* Yellow represents frequencies with a high level of sound

Notice how the bulk of the sound is in the lower frequencies -- less than 500 cycles? Well, this
is partly due to the fact that I'm a guy. Girls have somewhat higher voices, but a surprising
amount of audio is in low frequencies for both guys and girls.

Notice, also, that I have almost no frequencies above about 5 kHz. Girls would max out around
8 kHz. Remember that point, we'll come back to it.

FREQUENCY MEANS DIFFERENT THINGS

Human hearing ranges from 20 cycles (so deep as to feel more like a vibration than a pitch) to
20,000 cycles (so high as to feel more like the wind than a tone); assuming we are all about 18
years old with average hearing for that age. As we get older, our hearing declines, which I have
already grumped about.

NOTE: Two other thoughts about getting older. First, we lose high frequency
hearing first. Second, guys start to lose higher frequencies before girls do.

Human speech, however, is more restricted in frequencies. Speech ranges from roughly 150
cycles to 6,000 cycles for men, and 350 cycles to 8,000 cycles for women. Kids are slightly
higher yet. And, there is plenty of individual variation.

That which adds richness, tone, and "sexiness" to a voice are the lower frequencies. (This is
why many radio DJ's try to pitch their voice as deep as they can.)



Vowels live in the low frequencies.

Consonants, however, live in the high frequencies. And it is consonants that provide diction to
speech.

NOTE: Someone who mumbles has almost no high-frequencies in their voice,
which is why they are so hard to understand. It isn't just volume, it's pitch.

I read somewhere that the difference between the letter "F" and "S" is 6,100 cycles for a guy
and 8,000 cycles for a girl. In other words, clarity is in the high frequencies.

This last statement gives us guidance on how to approach mixing projects for, ah, older folks.
We need to boost the higher frequencies to improve intelligibility.

ADDING EQ TO THE MIX

One of the reasons I like mixing in Soundtrack Pro is the high-quality and precise filters that it
contains, coupled with a sophisticated interface. Final Cut's filters can't begin to compete.

While it is true that every voice is different and that you should never use the same preset for
everyone, I'm going to give you a couple of settings you can use as starting points to improve
your own mixes.

In Soundtrack, unlike Final Cut, filters are applied to the track, not the clip. So, select a track by
clicking on it. Here, I clicked the track Larry Intro.

Then, click the Effects tab to select it; the default location is in the Left Pane.

The left side of the window shows filter categories. Click EQ.

The right side of the window shows filters. Either double-click the filter named Fat EQ or
highlight it and click the Plus button.



The filter interface that appears has been known to scare small children. However, it isn't as bad
as all that.

As I said, human hearing extends from 20 cycles, on the left, to 20,000 cycles, on the right. The
Fat EQ filter separates this into five bands, going from left to right:

* Frequencies below human speech
* Low-frequency human speech
* Mid-range human speech
* High-frequency human speech
* Frequencies above human speech

While this filter has a LOT of flexibility, I want to concentrate on two things:

* Making a voice sound warmer
* Making a voice easier to understand

The warmth of a voice is in the lower frequencies -- Band 2. As we increase this setting, we
make a voice more inviting. As we decrease this setting, we make a voice more sterile.



The Fat EQ filter allows us to increase or decrease specific ranges of frequencies. This allows
us to change portions of the sound without changing all of it. This is very similar to color
correction, where we can change the color of the shadows while not changing the color of
highlights.

To vary the amount of the change, drag the circular wheel up or down.

NOTE: When we change frequencies, we want to make small changes. We are not
creating mountains here, we are creating molehills!

To vary the frequencies we are changing, grab the frequency number and drag it up or down.
(You can also double-click it to enter a specific number.)

Notice that we are not changing a specific frequency. We are changing a range of frequencies
around a central point. When we work with audio, we are always working with ranges, not
specific frequencies.

Now that you know how to make changes to the filter, let's look at some specific settings that we



can use to improve our sound.

GENERAL SETTINGS FOR A MALE VOICE

NOTE: Before the emails start flying, allow me to state, again, that every voice is different. Use
these as guides, then adjust until the voice sounds good to your ears.

I recently changed my opinions on where to set my presets and I'm continuing to refine them.
However, to warm up the low-end of a voice, I'll add +3 dB of gain around 170 cycles. Then, to
improve clarity, I'll add +4.5 dB of gain around 3500 cycles.

Finally, I'll drop the Master Gain by -1 dB to help prevent distortion caused by boosting
frequencies.

GENERAL SETTINGS FOR A FEMALE VOICE

I do much less work with female voices, but when I do, here is where I start.



To warm up the low-end of a voice, I'll add +3 dB of gain around 390 cycles. Then, to improve
clarity, I'll add +4.5 dB of gain around 5500 cycles.

Finally, I'll drop the Master Gain by -1 dB to help prevent distortion caused by boosting
frequencies.

SUMMARY

By boosting the high-frequencies a bit, I add sparkle and clarity to the voice to help make sure
that what my actors are saying is intelligible to the audience. Even us older folks...!

BIG NOTE: If you, like me, use the Limiter filter to help even out levels, be sure to
apply the Limiter filter LAST, so it is at the bottom of the filter stack. Otherwise,
the EQ filter is likely to distort your audio.

[ Go to Top. ]

MORE THOUGHTS ON AUDIO LEVELS



I've already written on checker-boarding audio clips in a Final Cut Pro timeline, and
some recommended audio levels. (You can read that article here.)

However, recently, I was talking with the tech support folks at Aphex, who make high-
end audio gear for network and broadcast work.

They told me that MP3 files are optimized for a maximum audio level of -6 dB, while
AAC files are optimized for a maximum audio level of 0 dB.

Since much of the audio work that I do gets compressed into both formats, I've lowered
my audio levels a bit so that they are peaking closer to -6 dB than -3 dB.

They still sound good and I get nice clean results when compressing to MP3 files.

(For the record, almost all my encoding is the spoken word, as opposed to music, and I
use a data rate of 56 kbps for MP3 compression of mono audio files.)

NORMALIZING

Based on this, when I normalize clips, I'm now normalizing to -4.5 dB. I also use the same level
settings when using the Limiter filter in Soundtrack Pro.

FINAL CUT AUDIO METERS

I'm sure I mentioned this somewhere, but, if not, just a quick note that the audio meters inside
Final Cut measure audio peaks on a 0 dBFS scale. There are other audio measures, such as
PPM in the UK and Europe, and average level meters, which can be added to FCP.

So, if you are confused, as I was awhile back when talking with an audio engineer who wanted
to mix all the audio to -20 dB, while I wanted to mix it a LOT higher, remember that average
audio level and peak levels are not the same thing.

Regardless, remember that your audio levels still can't go over 0 dB. Not even a little.
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PASSING THOUGHTS

Short thoughts on a variety of topics.

Recent arrivals on KenStone.net

Apple Cinema Tools Overview by Dan Brockett

"Cinema Tools is an interesting and often misunderstood utility that has been
shipping with Apple Final Cut Studio since 2004. Many editors are not even sure
of what Cinema Tools function is. The application is a database application that
tracks the relationship between film frames and their corresponding video frames."

http://www.kenstone.net/fcp_homepage/apple_cinema_tools_overview_brockett.html

Digital Rebellion by Ken Stone

"For some time now, users of FCP and FC Studio, have had a friend watching
their backs. His name is Jon Chappell and he runs the 'Digital Rebellion'web site,
which offers us is tools, tools that help us with running Final Cut Studio."

http://www.kenstone.net/fcp_homepage/digital_rebellion_stone.html

http://www.larryjordan.biz/articles/lj_audio_levels.html
http://www.aphex.com/
http://www.kenstone.net/
http://www.kenstone.net/fcp_homepage/apple_cinema_tools_overview_brockett.html
http://www.kenstone.net/fcp_homepage/digital_rebellion_stone.html


Holophone's PortaMic PRO Surround Microphone, review by Steve Douglas

"On top the tremendous growth and wave of high-end home theaters systems that
have pervaded our domiciles for several years, it is only a reasonable expectation
that capturing and editing in full 5.1 surround sound should be part of the tsunami
surge of 3D camcorders and televisions headed our way."

http://www.kenstone.net/fcp_homepage/holophone_surcode_douglas.html

bermarte writes:

Here's another way to add timecode to a group of clips. I have a sequence of 2 h.
and I found my method (similar to after effects comp inside a comp): select an out
point for your sequence, create a new sequence, drag and drop first sequence
inside second sequence, apply timecode filter to new sequence; export.

Joe Hackett writes:

I am currently color grading a feature in FINAL CUT STUDIO. Some scenes I was
asked to 'AGE' and STYLIZE' but don't make it look too "Cold Case.'

I was up for the job, but didn't want to send the whole sequence to COLOR
because of all of the God for Saken transitions and layers applied.
So... hmmm can't roundtrip a clip.....to Color...

I literally "nested" single clips, creating a "Sequence" to send.

Odd thing though, it worked fine IF I STARTED the round trip from the browser,
and IF I replaced the "SEQUENCE FROM COLOR" EXACTLY over the spot
where I had created it.
If I put it on a different layer...all hell broke loose(couldn't see the new clips)

Make sense? It helped me a lot

Michael Cowan writes:

Thought you'd like to know there is a well-documented nested sequence/XML
problem that prevents "Send To" of nested sequences to Soundtrack Pro.

Jeremy Hughes wrote the Color workaround:
http://filmvideostuff.blogspot.com/2010/01/how-to-get-audio-from-nested-fcp.html
and here's the link to Apple Support's article about issues with XML exports from
FCP: http://support.apple.com/kb/TS2155.

So, to send files to STP, they need to be UNnested.

This is probably my favorite alert dialog of all time, submitted by Brad Boim.

http://www.kenstone.net/fcp_homepage/holophone_surcode_douglas.html
http://filmvideostuff.blogspot.com/2010/01/how-to-get-audio-from-nested-fcp.html
http://support.apple.com/kb/TS2155
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READER MAIL

WHAT CAMERA TO BUY

Ron Robinson asks:

I've been asked to put together a production system for corporate communications:
product promotion and instruction delivered on the web; and to produce HD
materials for client use as well. Delivery will be to the web, and HD LCD panels.
FCP will be used for all editing. There will be a moderately high level of
compositing required in the productions.

In a conversation the day of the seminar, you suggested the Panasonic HPX300,
which is a beautiful device, but budget constraints do not make that camera
possible at this time. As an alternative, I'm looking at the HMC150, which uses
inexpensive SD cards as recording media. The HPX170, for not a lot more money
appears to be a similar camera — the primary difference being it records to P2
cards. Also, the HCM150 records AVCHD; the PHX170 records DVCPRO HD, as
far as I can tell.

My dilemma is this: As I am establishing the direction of the corporate
communications department that I will be operating, is it wise to look at an SD-
based system, or are there advantages (workflow especially) in starting with a P2-
based system?

Larry replies: Ron, thanks for writing!

The world is rapidly moving away from SD. If you are buying gear to "set the future direction of
the company," then buy HD.

DVCPRO HD is easier and faster to edit than AVCHD - since AVCHD will need to be
transcoded to ProRes during the Log & Transfer process.

However, the AVC family of cameras will be cheaper.

My suggestion is to rent a couple of different cameras and do a test shoot. See which one
handles better, which works better in the lighting you expect to use, and which has the better
output.

Investing a bit more now to get gear that will last for several years is generally a good idea.
Keep in mind that camera formats are RAPIDLY in flux. Don't expect the camera you buy now to
last more than 3-4 years from an obsolescence point of view.

UPDATE - July 12, 2010

Nic 7320 pointed out that I was answering the wrong question:



that's not what he was asking. SD cards vs. P2 cards. Not standard def vs. high
def.

Larry replies: Oh! I was confusing SD video with SDHC cards.

Well, in that case, it all depends upon the format your camera supports. SDHC cards are
cheaper, but much less solidly built. However, an SDHC card reader is a fraction of the cost of
the P2 card reader.

P2 cards can survive train wrecks.

However, few cameras support both types of cards, since SDHC cameras record AVCHD, while
P2 cameras record DVCPROHD. DVCPROHD is a better format for editing and creates smaller
file sizes than AVCHD, since AVCHD needs to be transcoded into ProRes before Final Cut Pro
can edit it.

I think the better rule is pick the camera you like first, then worry about the cards. Regardless of
which card type you buy, with proper handling both will deliver quality results.

Assuming the same video format is recorded on each card, there is no difference in image
quality. However, since AVCHD and DVCPROHD are not the same format, doing a test with
each camera - for example, renting one for a weekend - would be a good idea to see which one
you like the best.

 

UPDATE -- June 28, 2010

Richard Boyd, of the Houston Community College, writes:

You might consider the JVC GY-HM100. It's at a similar price point, shoots
1920x1080, and records unwrapped Quicktime files to inexpensive (SDHD) media.

I recently purchased 12 cameras for students in our program to use. They seem to
be robustly constructed and the workflow with FCP is easy and very straight
forward. And, the footage looks good too!

Larry replies: Thanks, Richard, for the update.

UPDATE -- June 29, 2010

Zak Ray, from Worldwide Studios, adds:

In regards to Ron Robinson's question on what camera to buy, I think it's important
to note that the HMC-150 and GY-HM100 shoot to 4:2:0 codecs. If Ron is doing a
"moderately high level of compositing" as he says, he may want to get the 170 if
for no other reason than the 4:2:2 color space.

Larry replies: Thanks, Zak, for the comment.
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OUTPUT TO MONITOR

Jim Mitchell asks:

Is there anyway to output FCP 7 to a color-balanced NTSC monitor so you can
watch the picture live while you color-correct? Is there a Firewire preview mode in
FCP where an NTSC picture could be watched through an AJA IO box live while
color-correcting?



Larry replies: Certainly.

View > External Frames set to All.

View > Video Playback set to your output device.

So, if you have a FireWire deck or camera attached, FCP outputs to the deck, which then
displays on the monitor.

If you have a AJA card, FCP outputs to the card, which is connected to the monitor.
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INGESTING FOOTAGE VIA AJA

Here's a conversation between Peter Tours, of TNT Video Services, and Tony Lauria, of AJA
Technical Support, which I've reprinted with their permission.

Peter writes:

I am really confused about DVCPRO HD setups. My crew is shooting 720p24N.
What easy setup should I be using if I monitor on an analog component SD Sony
monitor? Should the crew change their settings? I spoke to Tony yesterday and he
really tried to explain this all to me but within an hour I confused myself again.

The crew uses a Panasonic HPX500. While we acquire in HD, our clients still want
SD masters only, either on BetaSP or DigiBeta.

Tony replies:

720P23.98 is an acquisition only format. You can have a sequence in that format
but you have to play it out at 720P59.94 as you have noticed. Also you cannot
down convert from 24 frame to standard def.

So the bottom line is that you clients will have to view the 720P59.94 footage
along with everybody else.

Peter continues:

So it follows that the crew should actually acquire 720P59.94 rather than 24p? Still
kinda confused.

Tony:

Since your delivery format has to be SD content, I'd recommend staying as simple
as possible, and that would mean capturing at 720p59.94. Some producers like the
24 frame look, but, ultimately, you've gotta output one of the broadcast standard
formats. To save some headache and confusion it's best to stay away from the 24
frame content and stick with a broadcast format.

That being said, we *do* talk to quite a few people who have 23.98 frame rate
material, and it's not generally a problem. In Final Cut, the video playback setting
is simply set to the broadcast frame rate 29.97 or 59.94, and playout works just as
well.

I think one of the issues here is that various producers/videographers, like the look
of the 24 frame captures, but there are many who think it adds an excessive
stutter to the video. In your case, the workflow is easy in either frame rate.

Here's my step by step procedure for importing the footage file you sent, into Final
Cut:



I opened Final Cut, and immediately chose Easy Set Up. I picked this:

FYI, I can also achieve success using a 720p59.94 sequence preset. Most
importantly is the video playback setting.

When I imported the clip, using File > Import, FCP prompted to change the
sequence settings to match the video content. I chose YES. I have not researched
what this actually changed. To do so I would have to select NO when prompted,
then compare the changed sequence settings to the unchanged. However, I don't
really think that's too important here, since we're achieving successful playback
anyway.



As a side note. these system settings are recommended:

Larry concludes: Thanks to both Tony Lauria, AJA Technical Support and Peter Tours for
sharing their conversation with us.
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CREATING MACROS IN FINAL CUT PRO

Jim Mitchell also asks:

How do you build Macros (several mouse clicks) into a single button for repetitive
tasks? Where may I read these instructions for building MACROS? Sorry. Second
question of the day.

Larry replies: Currently, Final Cut Pro doesn't support macros.



You can create simple animation using Automator.

You can also add applications like QuicKeys (http://startly.com/products/quickeys/mac/4/), but
Final Cut was written so long ago that it doesn't provide the kind of hooks developers need add
automation.

It is my hope this will change in the next version, but for now, automation is very limited inside
Final Cut Pro.
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OUTPUTTING TO TAPE

Ralph Bevins writes:

I've generally copied QT movies to tape for archival purposes by importing the
QuickTime file into the browser, double-clicking into the viewer and playing it to
tape.
Is the quality the same as if I played it, or the original project, out of the timeline
using print to tape?

Larry replies: This works, but the default settings inside Final Cut potentially decrease both
audio and video quality. Instead, for the best quality, I recommend File > Output to Tape.
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GETTING VIDEO FROM A DVD

John, in Alaska, writes:

We have a video "issue." Used a new camcorder for recording our concerts last
month, which uses a card, no tape. We downloaded the card to computers...and
voila - a movie. However, somehow the card got erased so what we now have is
several copies on computers, portable HDs, etc. Our assistant has been
reformatting our Hi 8 tapes from the past onto DVDs so she volunteered to do this
one, too. See says the files aren't .mpeg but are .mod and she can't deal with that
extension. But when I ope up my files, it says that they are .mpeg - however, if I
try and open it as an .mpeg, it won't open. I have to use the "All files" option. Long
story short - can you help us?

Larry replies: Yes, there are two options that i know of that can help. With over a dozen flavors
of MPEG-2, the situation can get very confusing.

Check out:

MPEG Streamclip, Squared 5 software -- http://www.squared5.com/ -- a free
utility.

Handbrake -- http://handbrake.fr/ -- an open-source software
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REMOVING AUDIO TRACKS

Brandon Lindquist writes:

So, I have footage that was shot with 4 tracks of audio.

First 2 tracks - Cam mic

http://startly.com/products/quickeys/mac/4/
http://www.squared5.com/
http://handbrake.fr/


Second 2 tracks - Empty

For the production, they recorded audio on an external device, with 4 tracks.

First 2 tracks - Good Audio
Second 2 tracks - Empty

When I merge the video and audio clips I get a Merged Clip with 8 tracks of audio.
The useable audio being on tracks 5 and 6. This is of course a huge pain the butt.

Is there anyway in FCP to remove certain audio tracks from the merged clip? 
Is there even a way to remove audio tracks from the clips themselves?
I can't find an answer to that question, so its leaving me to believe there isn't a
way.
I would also much rather not change the original source files, like in some
solutions I've come across.

Larry replies: Yes and Yes.

Without changing the source clips

Edit a clip into the FCP Timeline.
Turn linking off
Option click on the audio clip you don't want, this selects it.
Press delete to get rid of it.

Do this for as many audio tracks as you need, then merge the clip

With changing the source files.

Open the clip in QuickTime 7 Pro -- NOT QuickTime X
Type Command+J
Disable the audio tracks listed at the top of the window - this mutes them but doesn't
delete them
-OR- Select the audio tracks you want to delete and click the delete button. The tracks
are permanently gone.

Brandon adds:

Thanks - this helps a lot. By the way, I was looking for a way to automate this, and here's what
I found.

I synced and merged all my clips(138 of them).
Exported them and all their 8 tracks of audio.
Then used qtChange 1.2 to delete all my unwanted audio tracks.(It doesn't transcode
them. It "changes" them. It did all 138 in like 10min)
I then imported the "changed" clips into FCP, and all my footage was synced with just
the 2 tracks I needed.

Heres the link to the qtChange site:
http://www.videotoolshed.com/product/42/qtchange

Larry replies: Thanks for the additional information.
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LOOKING FOR AUDIO WITH TIMECODE

Don Arbuckle writes:

We just finished post audio in 5.1 for an indie film shot at 23.97. We posted the

http://www.videotoolshed.com/product/42/qtchange


audio to an NTSC 29.97 picture

The filmmakers have hired a company to prep this for the festivals which they are
entered. This transfer company is making a JPG2000 and has asked me to give
them a True 24p wav for audio for the mix

Now what?

Larry replies: Ah, they are looking for a file in Broadcast WAV format. This format includes
timecode.

You have two options: do it yourself or get your audio post house to do it.

If you want to do it yourself, read here:

http://www.ehow.com/how_5149727_convert-wav-files-bwf-format.html

Or contact your facility.
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POSITIONING TEXT

Jennifer, from Needlegarden, writes:

I'm emailing because though I consider myself an experienced Final Cut user, and
have tackled many difficult issues, one thing keeps bugging me -- when I use text
generator to create a title, sometimes the text runs off the right side of the frame
and is cut off. Especially if I justify left. I would think that by moving the frame
around in the motion tab I would be able to place it properly, but it still shows up
cut off -- see image attached.

The title is supposed to say "Former Prospect Plaza Resident" but gets cut off and
there's nothing I've found that can fix that except centering it and making two
separate titles and placing them independently. Just a little thorn in my side.

Any thoughts here?

Larry replies: Thanks for writing, Jenn.

When you Left justify text, the bottom left corner of the first letter becomes the 0 point for
positioning. When you center text, the 0 point is the center of all the text.

In other words, the point of positioning moves as you change justification.

The Motion tab moves the FRAME that contains the text. The Controls tab moves the text
WITHIN the frame. Adjusting text position in the Motion tab won't reveal characters that are
outside the frame itself.

A MUCH better way to adjust this is using the Origin settings in the Controls tab. This allows
you to position all your text, without moving the frame that contains the text.
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PREPPING STILLS FOR FINAL CUT PRO

Amanda Lotas writes:

Thanks for your webinar yesterday. It was good to learn about PhotoMotion
especially. I was hoping I could ask you 2 questions as related to prepping stills
for

http://www.ehow.com/how_5149727_convert-wav-files-bwf-format.html


fcp:

1. When I bring photoshop images that were created with an Adobe RGB into
fcp they look washed out. A few websites I've found claim that you need to
convert the images in photoshop to an Apple RGB profile b/f taking them into
fcp. I do this now b/c the colors look much better in fcp and upon qt
export. What do you know about this topic?

2. I've attached my choices for sequence settings - I'm still in fcp 5.0.4
on a G5. In the past I've used DV NTSC 48 kHz for photos with square pixels
for slideshows to export as flvs. But you said yesterday that quality is not
good. You suggested ProRes. I don't have that. What might you suggest in its
stead? How else can I keep photos progressive/best quality? This slideshow
is for web only.

Thank you so much and hope to hear from you!!!!!!

Larry replies: Amanda, thanks for writing.

1. The change in color is not a change is color, but a change in gray scale, called the "gamma
setting." This determines where the mid-point gray is of an image. With all Macs before OS X
10.6, the gamma was set to 1.8; however, video uses 2.2. This means that images on the Mac
looking brighter.

The problem is that the gamma settings don't match, which means that when you load that
image into video it looks washed out.

Apple starting to fix this starting with FCP 5.1.4. And with the release of OS X 10.6, Apple
changed the system gamma setting to 2.2, so it matches that of video.

For now, though, I suggest you apply a color profile of EITHER SRGB or SMPTE-C to your stills
to get the gamma settings to match. It will look darker on your Moc monitor, but it will look right
in video.

2. The best quality to use for standard def images, given your system, is Uncompressed 10-bit.
Second, is DV50. Third, is DV NTSC (or DV PAL).
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PROBLEMS WITH MULTICLIPS

Michael Chirilov asks:

I have a problem trying to use the Multicam option in Final Cut 7. I know the
Multicam option requires clips shot with similar cameras. This is where my problem
starts.

I am using a Panasonic AG-HVX200 and a Sony Handycam HDR-SR11. Both are
good cameras but they shoot at different frame sizes. Sony = 1440 X 1880 and
Panasonic = 1280 x 1440 or anything else except 1440 X 1880. I’m getting the
error: ‘Unable to make a Multiclip. The video frame sizes don’t match.’ I cannot set
the Panasonic camera to record in 1440 X 1880 and at this time I can’t afford
another camera. What can I do to bring this to cameras to the same common
denominator. I tried using them outside the Multicam option, but is very tedious
work and you can still see small differences especially when it comes to sound
synchronization. I would really appreciate your input.

Larry replies: Michael, multicilps require that all clips in the multiclip be the same codec, image
size, frame rate, and scanning (progressive vs. interlaced).



The only way to fix this is to transcode your clips into a common format. This is where ProRes
comes in. Convert them both to the same format and you'll be able to use multiclip again.

I recently did a webinar on transcoding. You can learn more about it here.
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AUDIO THOUGHTS

Lee Berger writes:

Your recent Low Audio Tip suggests stacking audio tracks to boost audio, or better
yet using the Normalize command. Two other options are to use the FCP Gain
FIlter or the AU Dynamics Processor if you want to add a compressor/limiter.

Larry replies: Lee, these are good points.

Just so you know, the Normalize option is simply an automated way of applying the Gain filter,
without the risk of distortion -- I just figured that out this week. Also, the Gain filter can only raise
gain +12dB.

And I really don't like any of the audio filters inside FCP itself. However, for folks that don't know
Soundtrack Pro, this filter is better than nothing.

[ Go to Top. ]

CREATING A NEW USER ACCOUNT

Bill Yahraus asks:

Larry, a truoble-shooting tip that is often suggested is to create a new user on the
computer. What does the new user account fix?

Larry replies: Bill, a new user account basically resets EVERYTHING -- FCP preferences, OS
prefs, QT prefs, every preference everywhere.

It does NOT affect any projects you've created or anything inside those projects.

My suspicion is that the dropped frame errors are occuring because of latent conflicts in the
operating system, not in something inside your FCP project.

Creating a new user does no harm to your existing project because it doesn't touch the project.
However, you will lose access - while you are in that new account, to your existing home
directory and email.

When you log back into your existing user account, your home directory, email and everything
else will come back.

So, if this works, you can switch into the new user account for editing, then switch back to your
existing account for everything else.

I've had to do this a few times while I tracked down what was causing problems. Since no
current settings are deleted or altered, I have no hesitation in recommending it to see if we can
get this working.

NOTE: If you, by accident, have files stored in your existing home directory, this is
a good way to find them because when you switch to your new user account, all
your home directory files go offline.
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WORKING WITH KEYNOTE FILES

Larry Vaughn asks:

Larry, question about using Keynote quicktime shows with FCP. I have the most
current version of each, and shoot in HDV with a Canon XH-A1. I don't like the
look of the Keynote letters with exporting at the HDV settings. What would you
suggest I use? Will the other settings merge correctly with my HDV shots which I
did at 30F, Canon's solution to 30P? Which setting is best? 
Thanks in advance.

Larry replies: Larry, any Keynote video will need to render.

Therefore, export as ProRes - to maintain quality. Since Keynote has no particular frame rate,
export at 29.97 (or 30, if you don't have that option). Then, let FCP render the file when you add
it to your sequence.
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WRAP-UP

Well, that's about it for this issue. I'm still wading thru all the email, I'll put more answers in my
blog.

For current news and in-depth interviews on what's happening in our industry, be sure to listen
to the Digital Production BuZZ every week. In fact, put the free BuZZ player on your web site!
It's fast, simple, and very cool.

Also, please consider supporting this newsletter by:

Registering for one of my webinars.
Buying a tutorial - decrease your stress and get back to work.
Or, buy a mouse pad -- you know you need a new one...

Also, please continue sending me your comments and questions. I love hearing from you and
enjoy the conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter!

Email:  

[ Click here for a printer-friendly PDF version of this issue. 2.0 MB ]
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these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the
property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2010 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter
may not be reproduced or published in any way, in whole or in part, without specific written
permission from the author.

Links to my home page, blog, or web site articles are welcome and don't require prior
permission.
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